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Popular shortcuts
Result Windows mac0S
Free Transform Control + T Command + T
Decrease Brush Size [ [
Increase Brush Size 1 1
Decrease Brush Hardness { {
Increase Brush Hardness } }
Default Foreground/Background colors D D
Switch Foreground/Background colors X X
New layer via copy Control + J Command + )
New layer via cut Shift + Control +) Shift + Command + ]
Add to a selection Any selection tool + Shift- | Any selection tool + Shift-
drag drag
Delete brush or swatch Alt-click brush or swatch Option-click brush or swatch
Toggle auto-select with move tool Control-click Command-click
Cancel any modal dialog window (including the Start Escape Escape
Workspace)
Select the first edit field of the tool bar Enter Return
Navigate between fields Tab Tab
Navigate between fields in opposite direction Tab + Shift Tab + Shift
Change Cancel to Reset Alt Option




Invoke the search experience

Result Windows & macOS
Search across Photoshop Ul Help & Learn content, and Adobe Stock assets. For more Control + | Command +
information, see Photoshop search. F F
Result Windows macOS

Start Help Fl Help key

Undo/Redo A

Cut F2 F2

Copy =} F3

Paste F4 F4

Show/Hide Brush panel F5 Fs

Show/Hide Color panel F& F&

Show/Hide Layers panel F7 F7

Show/Hide Info panel Fa Fa

Show/Hide Actions panel Fg Option + F9

Revert F12 F2

Fill Shift + F5 Shift + F5

Feather Selection Shift + F& shift + F&

Inverse Selection Shift + F7 Shift + F7




Use function keys

Mote: 0

For macOs, press and hold the Fn key olong with the function key (FI-FI12) to override defoult macOS functions such as screen brightness, volume,
etc. For more information on the behaviour of function keys on your Mac, refer to these Apple documentations:

~  macOs Sherra: Use keyboard funchion keys
- Change the behavior of funchion keys on your Mac

Result Windows mac05

Select tools

Holding down a key temporarily activates a tool. Letting go of the key returns to the previous tool

Mote: (i ]

In rows with multiple tools, repeatedly press the same shortout to toggle through the group.

Result Windows macO5s

Cycle through tools with the Shift-press shortout key (if Use Shift Key Shift-press shortout key (if Use Shift Key for

same shortout key for Tool Switch preference is selected) Tool Switch preference is selected)

Cycle through hidden tools Alt-click + tool (except Add Anchor Point, | Option-click + tool (except Add Anchor
Delete Anchor Point, and Convert Point Point, Delete Anchor Point, and Convert
tools) Point tools)

Move tool v v

Rectangular Marquee toal’ M M

Elliptical Marguee tool

Lasso tool L L
Polygonal Lasso tool

Magnetic Lasso tool

Magic Wand tool w w

Quick Selection tool



Crop tool
Slice tool
Slice Select tool

Eyedropper tool"
Color Sampler tool

Ruler tool

Note tool

Spot Healing Brush tool
Healing Brush tool
Patch tool

Red Eye tool

Brush tool
Pendil tool

Color Replacement tool
Mixer Brush tool

Clone Stamp tool

Pattern Stamp tool

History Brush tool

Art History Brush tool

Eraser toolf
Background Eraser tool

Magic Eraser tool




Gradient tool
Paint Bucket tool

Dodge tool
Bumn tool

Sponge tool

Pen tool

Herizontal Type tool
Vertical Type tool
Horizontal Type mask tool
Vertical Type mask tool

Path Selection tool
Direct Selection tool

Rectangle tool
Rounded Rectangle tool
Ellipse tool

Polygon tool

Line tool

Custom Shape tool

Hand toolt

Rotate View tool




Zoom toolt

Default Foreground/Background
colors

Switch Foreground/Background
colors

Toggle Standard/Quick Mask
modes

Content-Aware Move tool

Perspective Crop tool

Artboard tool

Rotate View tool

Toggle Preserve Transparency

! (forward slash)

Dewrease Brush Hardness

{

Increase Brush Hardness

I

Previous Brush

Mext Brush

First Brush

Last Brush

tUse same shortcut key for Liquify




View images

This partial list provides shortouts that don't appear in menu commands or tool tips.

Result

Cycle through open documents

Switch to previous document

Close a file in Photoshop and open Bridge

Toggle between Standard mode and Quick Mask
mode

Toggle (forward) between Standard screen
mode, Full screen mode with menu bar, and Full
screen mode

Toggle (backward) between Standard screen
mode, Full screen mode with menu bar, and Full
screen mode

Toggle (forward) canvas color

Toggle (badkward) canvas color

Fit image in window

Magnify 100%

Windows

Control + Tab

Shift + Control + Tab

Shift-Control-W

Shift + F

Spacebar + F (or right-click canvas
background and select color)

Spacebar + Shift + F

Double-click Hand tool

Double-click Zoom tool or
Ctrl +1

mac05

Control + Tab

Shift + Command + “(grave accent)

Shift-Command-W

Shift + F

Spacebar + F (or Control-click
canvas background and select
color)

Spacebar + Shift + F

Double-click Hand tool

Double-click Zoom tool or

Command +1



Switch to Hand tool (when not in text-edit
mode)

Simultaneously pan multiple documents with
Hand tool

Switch to Zoom In tool

Switch to Zoom Out tool

Move Zoom marquee while dragging with the
Zoom tool

Apply zoom percentage, and keep zoom
percentage box active

Zoom in on specified area of an image

Temporarily zoom into an image

Scroll image with Hand tool

Saroll up or down 1 screen

Scroll up or down 10 units

Move view to upper-left comer or lower-right
corner

Toggle layer mask on/off as rubylith (layer mask
must be selected)

Shift-drag

Control + spacebar

Alt + spacebar

Spacebar-drag

Shift + Enter in Mavigator panel
zoom percentage box

Control-drag over preview in
MNavigator panel

Hold down H and then dlick in the
image and hold down the mouse
button

Spacebar-drag, or drag view area
box in Navigator panel

Page Up or Page Down'

shift + Page Up or Page Down'

Home or End

\ (backslash)

Shift-drag

Command + spacebar

Option + spacebar

Spacebar-drag

Shift + Return in Navigator panel
zoom percentage box

Command-drag over preview in
MNavigator panel

Hold down H and then dick in the
image and hold down the mouse
button

Spacebar-drag, or drag view area
box in Navigator panel

Page Up or Page Downt

shift + Page Up or Page Down'

Home or End

\ (backslash)

tHold down Ctrl {(Windows) er Command (mac0s) to scroll left (Page Up) or right (Page Down)



Use Puppet Warp

This partial list provides shortcuts that don't appear in menu commands or tool tips.

Result Windows mac0s
Cancel completely Esc Esc
Undo last pin adjustment Cirl+Z Command +Z
Select all pins Ctrl + A Command + A
Dreselect all pins Ctrl+D Command + D
Select multiple pins Shift-click Shift-click
Meove multiple selected pins Shift-drag Shift-drag
Tempaorarily hide pins H H
Use Refine Edge
Result Windows macOs
Open the Refine Edge dialog box Control + Alt + R Command + Option + R
Cycle (forward) through preview modes F F
Cycle (backward) through preview modes Shift + F Shift + F
Toggle between original image and selection preview X X
Toggle between original selection and refined version P p
Toggle radius preview on and off | J
Toggle between Refine Radius and Erase Refinements tools Shift + E Shift+ E

10



Use the Liquify filter

Result Windows macOs

Forward Warp tool w w

Reconstruct tool R R

Twirl Clockwise tool C C

Pucker tool 5 5

Bloat tool B B

Push Left tool o] o]

Mirror tool M ]

Turbulence tool T T

Freeze Mask tool F F

Thaw Mask tool D D

Reverse direction for Bloat, Pucker, Alt + tool Option + tool

Push Left, and Mirror tools

Continually sample the distortion Alt-drag in preview with Reconstruct Option-drag in preview with
tool, Displace, Amplitwist, or Affine Reconstruct tool, Displace, Amplitwist,
mode selected or Affine mode selected

11




Use the Filter Gallery

Result

Apply a new filter on top of selected
Reapply last-used filter

Open/close all disclosure triangles
Change Cancel button to Default
Change Cancel button to Reset
Undo/Redo

Step forward

Step backward

Continually sample the distortion

Decreasefincrease brush size by 2, or
density, pressure, rate, or turbulent
jitter by 1

Decreasefincrease brush size by 2, or
density, pressure, rate, or turbulent
jitter by 1

Cycle through controls on right from
top

Cycle through controls on right from
bottom

Change Cancel to Reset

Windows

Alt-click a filter
Control + Alt + F

Alt-cick a disclosure triangle

Control

Alt

Control + Z

Control + Shift + Z

Control + Alt + Z

Alt-drag in preview with Reconstruct
tool, Displace, Amplitwist, or Affine
mode selected

Down ArrowfUp Ammow in Brush Size,
Density, Pressure, Rate, or Turbulent

Jitter text boxT

Left Arrow/Right Arrow with Brush Size,
Density, Pressure, Rate, or Turbulent

Jitter slider showing’

Tab

Shift + Tab

Alt

tHold down Shift to decrease/increase by 10

12

Option-click a filter
Control + Command + F

Option-dlick a disclosure triangle

Command

Option

Command + Z

Command + Shift + Z

Command + Option +Z

Option-drag in preview with

Reconstruct tool, Displace, Amplitwist,
or Affine mode selected

Down Armow/Up Arrow in Brush Size,
Density, Pressure, Rate, or Turbulent

Jitter text box®

Left Arrow/Right Arrow with Brush Size,
Density, Pressure, Rate, or Turbulent

Jitter slider showing®

Tab

Shift + Tab

Option



Use Vanishing Point
Result
Zoom 2x (temporary)
Zoom in
Zoom out

Fit in view

Zoom to center at 100%

Increase brush size (Brush, Stamp tools)
Decrease brush size (Brush, Stamp tools)
Increase brush hardness (Brush, Stamp tools)
Decrease brush hardness (Brush, Stamp tools)
Undeo last action

Redo last action

Deselect all

Hide selection and planes

Move selection 1 pixel

Windows

Control + + (plus)

Control + - (hyphen)

Control + 0 (zero), Double-click
Hand tool

Double-click Zoom tool

Shift +]

Shift + [

Control + Z

Control + Shift + Z

Control + D

Control + H

Arrow keys

mac05

Command + + (plus)

Command + - (hyphen)

Command + 0 (zero), Double-click
Hand tool

Double-click Zoom tool

Shift + ]

shift + [

Command + Z

Command + Shift + Z

Command + D

Command + H

Arrow keys

13



Move selection 10 pixels

Copy

Paste

Repeat last duplicate and move

Create a floating selection from the current
selection

Fill a selection with image under the pointer

Create a duplicate of the selection as a floating
selection

Constrain selection to a 15° rotation

Select a plane under ancther selected plane

Create 90 degree plane off parent plane

Delete last node while creating plane

Make a full canvas plane, square to the
camera

14

Shift + arrow keys

Control + C

Control +V

Control + Shift + T

Control + Alt+T

Control-drag

Control + Alt-drag

Alt + shift to rotate

Control-click the plane

Control-drag

Backspace

Double-click the Create Plane tool

shift + armow keys

Command + C

Command + V

Command + Shift + T

Command-drag

Command + Option-drag

Option + Shift to rotate

Command-dick the plane

Command-drag

Delete

Double-click the Create Plane tool



Use the Camera Raw dialog box

MNote:

Holding down a key temporarily activates a tool. Letting go of the key returns to the previous tool.

Result Windows mac05

Zoom tool z z

Hand tool H H

White Balance tool | |

Color Sampler tool 5 5

Crop tool C C

Straighten tool A A

Spot Removal tool B B

Red Eye Removal tool E E

Basic panel Ctrl + Alt+1 Command + Option + 1
Tone Curve panel Ctrl + Alt+2 Command + Option + 2
Detail panel Ctrl + Alt+ 3 Command + Option + 3

15




16

HSL/Grayscale panel

Split Toning panel

Lens Corrections panel

Camera Calibration panel

Presets panel

Open Snapshots panel

Parametric Curve Targeted Adjustment tool

Hue Targeted Adjustment tool

Saturation Targeted Adjustment tool

Luminance Targeted Adjustment tool

Grayscale Mix Targeted Adjustment tool

Last-used Targeted Adjustment tool

Adjustment Brush tool

Graduated Filter tool

Ctrl + Alt + 4

Ctrl + Alt + 5

Ctrl+ Alt+ 6

Ctrl + Alt +7

Ctrl + Alt + 9@

Ctrl + Alt + @

Ctrl + Alt + Shift + T

Ctrl + Alt + Shift + H

Ctrl + Alt + shift + 5

Ctrl + Alt + Shift + L

Ctrl + Alt + Shift + G

Command + Option + 4

Command + Option + 5

Command + Option + &

Command + Option + 7

Command + Option + 9 (macOS Universal
Access zoom shortcut must be disabled in
System Preferences)

Command + Option + 9

Command + Option + Shift+ T

Command + Option + Shift+ H

Command + Option + Shift + 5

Command + Option + Shift + L

Command + Option + Shift + G



Increase/decrease brush size

Increase/decrease brush feather

Increase/decrease Adjustment Brush tool flow in
increments of 10

Temporarily switch from Add to Erase mode for
theAdjustment Brush tool, or from Erase to Add
mode

Increase/decrease temporary Adjustment Brush tool
size

Increase/decrease temporary Adjustment Brush tool
feather

Increase/decrease temporary Adjustment Brush tool
flow in increments of 10

Switch to New mode from Add or Erase mode of
theAdjustment Brush tool or the Graduated Filter

Toggle Auto Mask for Adjustment Brush tool

Toggle Show Mask for Adjustment Brush tool

Toggle pins for Adjustment Brush tool

17

IH

Shift + ] 7 Shift + [

= (equal sign) [ -
(hyphen)

Alt

Alt+ ]/ Alt+[

Alt + shift + ] / Alt +
Shift + [

Alt + = (equal sign) /
Alt + - (hyphen)

Il

shift + ] 7 Shift + [

= (equal sign) / - (hyphen)

Option

Option + ] f Option + [

Option + Shift + ]/ Option + Shift + [

Option = (equal sign) / Option + - (hyphen)



Toggle overlay for Graduated Filter, Spot '} v
Removal tool, or Red Eye Removal tool
Rotate image left LorCtrl+] L or Command + ]
Rotate image right Ror Ctrl +[ R or Command + [
Zoom in Ctrl + + (plus) Command + + (plus)
Zoom out Ctrl + - (hyphen) Command + - (hyphen)
Temporarily switch to Zoom In tool Cirl Command
(Doesn't work when Straighten tool is selected. If
Crop tool is active, temporarily switches to
Straighten tool)
Temporarily switch to Zoom Out tool and change Alt Option
the Open Image button to Open Copy and the
Cancel button to Reset.
Toggle preview P P
Full screen mode F F
Temporarily activate the White Balance tool and Shift Shift
change the Open Image button to Open Object.
(Does not work if Crop tool is active)
Select multiple points in Curves panel Click the first point; Click the first point; Shift-click additional
Shift-click additional points
points

18




Add point to curve in Curves panel

Move selected point in Curves panel (1 unit)

Move selected point in Curves panel (10 units)

Open selected images in Camera Raw dialog box

from Bridge

Open selected images from Bridge bypassing

Camera Raw dialog box

Display highlights that will be clipped in Preview

Highlight clipping waming

Shadows dipping waming

(Filmstrip mode) Add 1- 5 star rating

(Filmstrip mode) Increase/decrease rating

(Filmstrip mode) Add red label

(Filmstrip mode) Add yellow label

(Filmstrip mode) Add green label

(Filmstrip mode) Add blue label

(Filmstrip mode) Add purple label

Camera Raw preferences

Deletes Adobe Camera Raw preferences

19

Control-click in

preview
Arrow keys
Shift-ammow

Ctrl+ R

Shift + double-dlick
image

Alt-drag Exposure,
Recovery, or Black
sliders

Ctrl+1-5

Ctrl +. (period) / Ctrl+,
(comma)

Ctrl+ &
Ctrl+7

Ctrl + 8

Ctrl+9
Ctrl + Shift + 0
Crl + K

Ctrl + Alt (on open)

Command-click in preview

Arrow keys

Shift-armow

Command + R

Shift + double-click image

Option-drag Exposure, Recovery, or Black
sliders

Command +1-5

Command + . (period) / Command+,
(comma)

Command + &

Command + 7

Command + 8

Command + 9

Command + Shift +0

Command + K

Option + Shift (on open)



Use the Black-and-White dialog box

Result

Open the Black-and-White dialog box
Increase/decrease selected value by 1%
Increase/decrease selected value by 10%

Change the values of the closest color slider

Use Curves
Result
Open the Curves dialog box
Select next point on the curve
Select the previous point on the curve
Select multiple points on the curve
Deselect a point
To delete a point on the curve
Move the selected point 1 unit
Move the selected point 10 units

Display highlights and shadows that will be
clipped

Set a point to the composite curve

Set a point to the channel curves

Toggle grid size

20

Windows

Shift + Control + Alt + B

Up Arrow/Down Armow

Shift + Up Arrow/Diown Arrow

Click-drag on the image

Windows

Control + M

+(plus)

— (minus)

shift-click the points

Control + D

Select a point and press Delete

Arrow keys

Shift + Arrow keys

Alt-drag black/white point
sliders

Control-click the image

shift + Control-click the image

Alt-click the field

macDs

Shift + Command + Option+ B

Up Arrow/Down Ammow

Shift + Up Arrow/Down Armow

Click-drag on the image

macOs

Command + M

+ (plus)

— (minus)

Shift-click the points

Command + D

Select a point and press Delete

Ammow keys

Shift + Arrow keys

Option-drag black/white point
sliders

Command-click the image

Shift + Command-dick the image

Option-click the field



Select and move objects

This partial list provides shortouts that don't appear in menu commands or tool tips.

Result

Repasition marquee while selecting?

Add to a selection

Subtract from a selection

Intersect a selection

Constrain marguee to square or circle (if
no other selections are active)t

Draw marquee from center (if no other

selections are active)?

Constrain shape and draw marquee from
centert

Switch to Move tool

Switch from Magnetic Lasso tool to Lasso
tool

Switch from Magnetic Lasso tool to
polygonal Lasso tool

21

Windows

Any marquee tool (except single

column and single row) + spacebar-

drag

Any selection tool + Shift-drag

Any selection tool + Alt-drag

Any selection tool (except Quick
Selection tool) + Shift-Alt-drag

Shift-drag

Alt-drag

Shift + Alt-drag

Control (except when Hand, Slice,
Path, Shape, or any Pen tool is
selected)

Alt-drag

Alt-click

mac05

Any marquee tool (except single
column and single row) + spacebar-
drag

Any selection tool + Shift-drag

Any selection tool + Option-drag

Any selection tool (except Quick

Selection tool) + Shift-Option-drag

Shift-drag

Option-drag

Shift + Option-drag

Command (except when Hand, Slice,
Path, Shape, or any Pen tool is selected)

Option-drag

Option-click



Apply/cancel an operation of the
Magnetic Lasso

Maove copy of selection

Move selection area 1 pixel

Move selection 1 pixel

Move layer 1 pixel when nothing selected

on layer

Increase/decrease detection width

Accept cropping or exit cropping

Toggle crop shield off and on

Make protractor

Snap guide to ruler ticks (except when
View > Snap is unchecked)

Convert between horizontal and vertical
guide

THold down Shift to move 10 pixels

*applies to shape tools

22

Enter/Esc or Control + _ (period)

Move tool + Alt-drag selection®

Any selection + Right Arrow, Left
Arrow, Up Arrow, or Down Arrow’

Move tool + Right Arrow, Left Arrow,
Up Arrow, or Down ArmowTf

Control + Right Amow, Left Arrow, Up

Arrow, or Down Arrow!

Magnetic Lasso tool + [ or ]

Crop tool + Enter or Esc

/ (forward slash)

Ruler tool + Alt-drag end point

Shift-drag guide

Alt-drag guide

Return/Esc or Command + . (period)

Mave tool + Option-drag selection+

Any selection + Right Amrow, Left Arrow,
Up Arrow, or Down Arrow!

Maove tool + Right Armow, Left Amrow, Up
Arrow, or Down AmmowTt

Command + Right Arrow, Left Arrow,
Up Arrow, or Down Arrow!

Magnetic Lasso tool + [ or ]

Crop tool + Return or Esc

1 {forward slash)

Ruler tool + Option-drag end point

Shift-drag guide

Option-drag guide



Transform selections, selection borders, and paths

This partial list provides shortouts that don't appear in menu commands or tool tips.

Result

Transform from center or reflect

Constrain

Distort

Apply

Cancel

Free transform with duplicate data

Transform again with duplicate data

23

Windows

Alt

Shift

Control

Enter

Control + . (period) or Esc

Control + Alt + T

Control + Shift + Alt + T

mac05

Option

Shift

Command

Return

Command + . (pericd) or Esc

Command + Option + T

Command + Shift + Option +T



Edit paths

This partial list provides shortouts that don't appear in menu commands or tool tips.

Result

Select multiple anchor points

Select entire path

Duplicate a path

Switch from Path Selection, Pen, Add Anchor
Point, Delete Anchor Point, or Convert Point
tools to Direct Selection tool

Switch from Pen tool or Freeform Pen tool to
Convert Point tool when pointer is over anchor
or direction point

Close path

Close path with straight-line segment

24

Windows

Direct selection tool + Shift-click

Direct selection tool + Alt-click

Pen (any Pen tool), Path Selection
or Direct Selection tool + Control
+ Alt-drag

Control

Alt

Magnetic Pen tool-double-dick

Magnetic Pen tool + Alt-double-
click

macO5

Direct selection tool + Shift-click

Direct selection tool + Option-click

Pen (any Pen tool), Path Selection or
Direct Selection tool + Command +
Option-drag

Command

Option

Magnetic Pen tool-double-dlick

Magnetic Pen tool + Opticn-double-
click



Use for painting

This partial list provides shortcuts that don't appear in menu commands or tool tips.

Result

Select foreground color
from color picker

Select foreground color
from image with
Eyedropper tool

Select background color

Color sampler tool

Deletes color sampler

Sets opacity, tolerance,

strength, or exposure
for painting mode

Sets flow for painting
mode

Mixer Brush changes
Mix setting

Mixer Brush changes
Wet setting

25

Windows

Any painting tool + Shift + Alt + right-click and
drag

Any painting tool + Alt or any shape tool + Alt
(except when Paths option is selected)

Eyedropper tool + Alt-click

Eyedropper tool + Shift

Color sampler tool + Alt-click

Any painting or editing tool + number keys
(e.g., 0="100%, 1=109%, 4 then 5 in quick
succession = 45%;) (when airbrush option is
enabled, use Shift + number keys)

Any painting or editing tool + Shift + number
keys (e.g., 0 =100%, 1 =10%, 4 then 5 in quick
succession = 45%) (when airbrush option is
enabled, omit Shift)

Alt + Shift + number

MNumber keys

macO5

Any painting tool + Control + Option +
Command and drag

Any painting tool + Option or any shape tool +
Opticn (except when Paths option is selected)

Eyedropper tool + Option-click

Eyedropper tool + Shift

Color sampler tool + Option-click

Any painting or editing tool + number keys
(e.g., 0="100%, 1=109%, 4 then 5 in quick
succession = 45%) (when airbrush option is
enabled, use Shift + number keys)

Any painting or editing tool + Shift + number
keys (e.g., 0 =100%, 1 =10%, 4 then 5 in quick
succession = 45%) (when airbrush option is
enabled, omit Shift)

Opticn + Shift + number

Number keys



Mixer Brush changes
Wet and Mix to zero

Cycle through blending | Shift + + (plus) or - (minus) Shift + + (plus) or - (minus)
modes

Open Fill dialogboxon |\ e or Shift + Backspace Delete OF Shift + Delete
background or standard

layer

Fill with foreground or

Alt + Backspace or Control + Backspace’

Option + Delete or Command + Delete?

background color

Fill from history Control + Alt + Backspacet Command + Option + Delete’
Displays Fill dialog box | Shift + Backspace Shift + Delete

Lock transparent pixels | [ (forward slash) | (forward slash)

on/off

Connects points witha | Any painting tool + Shift-click Any painting tool + Shift-click

straight line

THold down Shift to preserve transparency

26




Use for blending modes

Result Windows mac0s

Cycle through blending modes Shift + + (plus) or — (minus) Shift + + (plus) or — (minus)
MNormal Shift + Alt + N Shift + Option + N
Dissolve Shift + Alt +1 Shift + Option + 1
Behind (Brush tool only) shift + Alt + Q shift + Option + Q
Clear (Brush tool only) Shift + Alt + R Shift + Option + R
Darken Shift + Alt + K Shift + Option + K
Multiply Shift + Alt + M Shift + Option + M
Color Burn Shift + Alt + B Shift + Option + B
Linear Burn Shift + Alt + A Shift + Option + A
Lighten Shift + Alt + G Shift + Option + G
Screen Shift + Alt + 5 shift + Option + 5
Color Dodge Shift + Alt + D Shift + Option + D

27




Linear Dodge Shift + Alt + W Shift + Option + W
Overlay Shift + Alt + O Shift + Option + 0
Soft Light Shift + Alt + F Shift + Option + F
Hard Light Shift + Alt + H Shift + Option + H
Vivid Light Shift + Alt + v Shift + Option +V
Linear Light Shift + Alt + ] Shift + Option + ]
Pin Light Shift + Alt + 2 Shift + Option +Z
Hard Mix Shift + Alt + L Shift + Option + L
Difference Shift + Alt + E Shift + Option + E
Exclusion Shift + Alt + X Shift + Option + X
Hue Shift + Alt + U Shift + Option + U
Saturation Shift + Alt + T Shift + Option + T

28




Color Shift + Alt + C Shift + Option +C

Luminosity Shift + Alt + ¥ Shift + Option +Y

Desaturate Sponge tool + Shift + Alt+ D | Sponge tool + Shift + Option +

D

Saturate Sponge tool + Shift + Alt+5 | Sponge tool + Shift + Option + 5

Dodge/burn shadows Dodge tool/Burn tool + Shift | Dodge tool/Bum tool + Shift +
+Alt+5S Option + 5

Dodge/burn midtones Dodge tool/Bum toel + Shift | Dodge tool/Bumn tool + Shift +
+Alt+M Option + M

Dodge/burn highlights Dodge tool/Burn tool + Shift | Dodge tool/Bumn tool + Shift +
+Alt+H Option + H

Set blending mode to Threshold for bitmap images, Shift + Alt + N Shift + Option + M

Mormal for all other images

29




Select and edit text

This partial list provides shortouts that don't appear in menu commands or tool tips.

Result

Move type in image

Select 1 character left/right or 1 line
down/up, or 1 word left/right

Select characters from insertion point to
mouse click point

Move 1 character left/right, 1 line down/up,
or 1word left/right

Create a new text layer, when a text layer is
selected in the Layers panel

Select a word, line, paragraph, or story

Show/Hide selection on selected type

Display the bounding box for transforming
text when editing text, or activate Move
tool if cursor is inside the bounding box

Scale text within a bounding box when
resizing the bounding box

Maove text box while creating text box

30

Windows

Control-drag type when Type layer is
selected

Shift + Left Arrow/Right Arrow or
Down Arrow/Up Armow, or Control +
Shift + Left Arrow/Right Arrow

Shift-click

Left Arrow/Right Arrow, Down
Arrow/Up Armow, or Control + Left
Arrow/[Right Armow

Shift-click

Double-dlick, triple-dlick, quadruple-

dlick, or quintuple-dlick

Control + H

Control

Control-drag a bounding box handle

Spacebar-drag

Command-drag type when Type layer
is selected

shift + Left Arrow/Right Arrow or
Down Armow/Up Arrow, or Command
+ Shift + Left Arrow/Right Armow

Shift-click

Left Arrow/Right Arrow, Down
Arrow/Up Arrow, or Command + Left
Arrow/Right Arrow

Shift-click

Double-click, triple-click, quadruple-
dlick, or quintuple-click

Command + H

Command

Command-drag a bounding box
handle

Spacebar-drag



Format type

This partial list provides shortcuts that don't appear in menu commands or tool tips.

Result

Align left, center, or right

Align top, center, or bottom

Choose 100% horizontal scale

Choose 100% vertical scale

Choose Auto leading

Choose 0 for tracking

Justify paragraph, left aligns last line

Justify paragraph, justifies all

Toggle paragraph hyphenation onfoff

Toggle singlefevery-line composer on/off

Decrease or increase type size of selected text

2 points or pixels

Dearease or increase leading 2 points or pixels

Decrease or increase baseline shift 2 points or

pixels

Decrease or increase kemning/ftracking 201000

€ms

Windows

Horizontal Type tool + Control +
Shift + L, C, or R

Vertical Type tool + Control + Shift
+L,C,orR

Control + Shift + X

Control + Shift + Alt + X

Control + Shift + Alt + &

Control + Shift + Q

Control + Shift + )

Control + Shift + F

Control + Shift + Alt + H

Control + Shift + Alt + T

Control + Shift + < or =T

Alt + Down Arrow or Up Arrow

Shift + Alt + Down Arrow or Up
ArrowTT

Alt + Left Arrow or Right Arrow

tHold down Alt {Win) or Option (mac0S) to decrease/incarease by 10

Hiold down ctrl {Windows) or Command (mac05s) to decreasefinarease by 10
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mac0S

Horizontal Type tool + Command +
Shift + L, C, or R

Vertical Type tool + Command +
Shift + L, C, or R

Command + Shift + X

Command + Shift + Option + X

Command + Shift + Option + A

Command + Control + Shift + Q

Command + Shift+ )

Command + Shift+ F

Command + Control + Shift + Option
+H

Command + Shift + Option + T

Command + Shift + < or »T

Option + Down Armrow or Up AmowTt

Shift + Option + Down Arrow or Up
ArrowTt

Option + Left Arrow or Right Arrow



Slice and optimize

Result

Toggle between Slice tool and Slice Selection tool

Draw square slice

Draw from center outward

Draw square slice from center cutward

Reposition slice while creating slice

Open context-sensitive menu

Use panels

Windows

Control

Shift-drag

Alt-drag

Shift + Alt-drag

Spacebar-drag

Right-click slice

This partial list provides shortouts that don't appear in menu commands or tool tips.
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Result

Set options for new items (except for Actions, Animation, Styles, Brushes,
Tool Presets, and Layer Comps panels)

Delete without confirmation (except for the Brush panel)

Apply value and keep text box active

Show/Hide all panels

Show/Hide all panels except the toolbox and options bar

Highlight options bar

Increase/decrease selected values by 10

Windows

Alt-click New button

macds

Command

Shift-drag

Option-drag

Shift + Option-drag

Spacebar-drag

Control-dlick slice

macO5

Option-click New
button

Alt-click Delete button | Option-click Delete

Shift + Enter

Tab

Shift + Tab

Select tool and press

Enter

Shift + Up

Arrow/Down Arrow

button

Shift + Retum

Tab

Shift + Tab

Select tool and press
Return

shift + Up
Arrow/Down Arrow



Use the Actions panel
Result

Turn command on and all others off, or turmn all
commands on

Tum current modal control on and toggle all
other modal controls

Change action cr action set options

Display Options dialog box for recorded
command

Play entire action
Collapse/expand all components of an action
Play a command

Create new action and begin recording without
confirmation

Select contiguous items of the same kind

Select discontiguous items of the same kind
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Alt-click the check mark next to a
command

Alt-click

Alt + double-click action or action
set

Double-click recorded command

Control + double-click an action

Alt-click the triangle

Control-click the Play button

Alt-click the New Action button

Shift-click the action/command

Control-dlick the action/command

mac05

Option-dick the check mark next to
a command

Option-dlick

Option + double-click action or
action set

Double-click recorded command

Command + double-click an action

Option-dick the triangle

Command-click the Play button

Option-dick the New Action button

Shift-click the action/command

Command-click the
action/command



Use adjustment layers

Mote: 0

If you prefer channel shortcuts starting with Alt/Option + 1 for red, choose Edit > Keyboard Shortcuts, and select Use Legacy Channel
Shortcuts. Then restart Photoshop.

Result Windows macOs

Choose specific channel for adjustment Alt + 3 (red), 4 (green), 5 (blue) Option + 3 (red), 4 (green), 5 (blue)
Choose composite channel for adjustment Alt+2 Option + 2

Delete adjustment layer Delete or Backspace Delete

Define Auto options for Levels or Curves Alt-click Auto button Option-click Auto button

Use the Animation panel in Frames mode

Result Windows mac0s

Select/deselect multiple contiguous Shift-click second frame Shift-click second frame

frames

Select/deselect multiple discontiguous Control-click multiple frames Command-click multiple frames
frames

Paste using previous settings without Alt + Paste Frames command from Option + Paste Frames command from
displaying the dialog box the Panel pop-up menu the Panel pop-up menu
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Use the Brush panel
Result
Delete brush
Rename brush
Change brush size
Decreasefincrease brush softness/hardness
Select previous/next brush size
Select first/last brush
Display precise cross hair for brushes

Toggle airbrush option
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Windows

Alt-click brush

Double-dlick brush

Alt + right-click + drag left or right

Alt + right-click + drag up or down

, [comma) or . (period)

Shift +, (comma) or . (period)

Caps Lock or Shift + Caps Lock

Shift+ alt+ P

mac05s

Option-click brush

Double-click brush

Ctrl + Opticn + drag left or right

Ctrl + Opticn + drag up or down

, [comma) or . (period)

Shift +, (comma) or . (pericd)

Caps Lock

Shift + Option + P



Use the Channels panel

MNote:

Shortouts.

If you prefer channel shortcuts starting with CirlyCommand + 1 for red, choose Edit > Keyboard shortouts, and select Use Legacy Channel

Result

Select individual channels

Select composite channel

Load channel as selection

Add to current selection

Subtract from current selection

Intersect with current selection

Set options for Save Selection As
Channel button

Create a new spot channel

Select/deselect multiple color-

channel selection

Select/deselect alpha channel and
show/hide as a rubylith overlay

Display channel options

Toggle composite and grayscale
mask in Quick Mask mode
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Windows

Ctrl + 3 (red), 4 (green), 5 (blue)

Ctrl+2

Control-click channel thumbnail, or
Alt + Ctrl + 3 (red), 4 (green), 5 (blue)

Control + Shift-click channel
thumbnail

Control + Alt-click channel thumbnail

Control + Shift + Alt-click channel
thumbnail

Alt-click 5ave Selection As Channel
button

Control-click Create Mew Channel
button

shift-click color channel

Shift-click alpha channel

Double-click alpha or spot channel

thumbnail

~ (tilde)

macOs

Command + 3 (red), 4 (green), 5 (blue)

Command + 2

Command-dick channel thumbnail, or
Option + Command + 3 (red), 4 (green), 5
(blue)

Command + Shift-click channel thumbnail

Command + Option-click channel
thumbnail

Command + Shift + Option-click channel
thumbnail

Option-click Save Selection As Channel
button

Command-click Create Mew Channel button

Shift-click color channel

Shift-click alpha channel

Double-click alpha or spot channel

thumbnail

~ (tilde)




Use the Clone Source panel

Result

Show Clone Source (overlays image)

Mudge Clone Source

Rotate Clone Source

Windows

Alt + Shift

Alt + Shift + arrow keys

Alt + shift + < or =

Scale (increase or reduce size) Clone Source Alt + shift+ [ or ]

Use the Color panel
Result
Select background color
Display Color Bar menu

Cycle through color choices
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Windows

Alt-click color in color bar

Right-click color bar

Shift-click color bar

mac0O5

Option + Shift

Option + Shift + arrow keys

Opticn + Shift + < or =

Option + Shift+ [ or ]

mac05

Option-dlick color in color bar

Control-click color bar

Shift-dlick color bar



Use the History panel

Result

Create a new snapshot

Rename snapshot

Step forward through image states

Step backward through image states

Duplicate any image state, except the
current state

Permanently clear history (no Undo)

Use the Info panel
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Result

Change color readout modes

Change measurement units

Windows

Alt + New Snapshot

Double-click snapshot name

Control + Shift + £

Control + Alt + Z

Alt-click the image state

Alt + Clear History (in History panel
POp-up menu)

Click eyedropper icon

Click crosshair icon

mac05

Option + New Snapshot

Double-click snapshot name

Command + Shift + Z

Command + Option + Z

Option-click the image state

Option + Clear History (in History pamel
pOp-up menu)

mac0s

Click eyedropper icon

Click arosshair icon



Use the Layers panel

Result

Load layer transparency as a selection

Add to current selection

Subtract from current selection

Intersect with current selection

Load filter mask as a selection

Mew layer
Mew layer via copy

Mew layer via cut

Group layers

Ungroup layers

Createjrelease dlipping mask

Select all layers
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Windows

Control-click layer thumbnail

Control + Shift-click layer thumbnail

Control + Alt-click layer thumbnail

Control + Shift + Alt-click layer
thumbnail

Control-click filter mask thumbnail

Control + Shift+ N
Control +

Shift + Control + |

Control + G

Control + Shift + G

Control + Alt + G

Control + Alt + A

macO5

Command-dick layer thumbnail

Command + Shift-click layer thumbnail

Command + Option-dick layer
thumbnail

Command + Shift + Option-click layer
thumbnail

Command-dick filter mask thumbnail

Command + Shift+ N
Command + )

Shift + Command + )

Command + G

Command + Shift + G

Command + Option + G

Command + Option + A



Merge visible layers

Create new empty layer with dialog box

Create new layer below target layer

Select top layer

Select bottom layer

Add to layer selection in Layers panel

Select next layer down/up

Move target layer down/up

Merge a copy of all visible layers into
target layer

Merge layers

Move layer to bottom or top

Copy current layer to layer below

Merge all visible layers to a new layer
above the currently selected layer
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Control + Shift + E

Alt-click New Layer button

Control-click Mew Layer button

Alt + . (period)

Alt +, (comma)

Shift + Alt + [ or ]

Alt+[or]

Control + [ or ]

Control + Shift + Alt + E

Highlight layers you want to merge,
then Control + E

Control + Shift + [ or ]

Alt + Merge Down command from the
Panel pop-up menu

Alt + Merge Visible command from
the Panel pop-up menu

Command + Shift + E

Option-click Mew Layer button

Command-dlick New Layer button

Option +. (period)

Option +, (comma)

shift + Option + [or ]

Option + [ or ]

Command + [or]

Command + Shift + Option + E

Highlight the layers you want to merge,
then Command + E

Command + Shift + [ or ]

Option + Merge Down command from
the Panel pop-up menu

Option + Merge Visible command from
the Panel pop-up menu



Show/hide this layer/layer group only
or all layers/layer groups

Show/hide all other currently visible
layers

Toggle lock transparency for target
layer, or last applied lock

Edit layer effect/style, options
Hide layer effect/style

Edit layer style
Disablefenable vector mask

Open Layer Mask Display Options
dialog box

Toggle layer mask on/off
Toggle filter mask onfoff

Toggle between layer mask/composite
image

Toggle between filter mask/composite
image
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Right-dlick the eye icon

Alt-click the eye icon

[ (forward slash)

Double-click layer effect/style

Alt-double-click layer effect/style

Double-click layer

Shift-click vector mask thumbnail

Double-click layer mask thumbnail

Shift-click layer mask thumbnail

Shift-click filter mask thumbnail

Alt-click layer mask thumbnail

Alt-click filter mask thumbnail

Control-click the eye icon

Option-click the eye icon

[ (forward slash)

Double-click layer effect/style

Option-double-click layer effect/style

Double-click layer

Shift-click vector mask thumbnail

Double-click layer mask thumbnail

Shift-click layer mask thumbnail

Shift-click filter mask thumbnail

Option-click layer mask thumbnail

Option-click filter mask thumbnail



Select all type; temporarily select Type
tool

Create a clipping mask

Rename layer

Edit filter settings

Edit the Filter Blending options

Create new layer group below current
layer/layer set

Create new layer group with dialog box

Create layer mask that hides
all/selection

Create vector mask that reveals all/path
area

Create vector mask that hides all or
displays path area

Display layer group properties

Select/deselect multiple contiguous
layers

Select/deselect multiple contiguous
layers

Select/deselect multiple discontiguous
layers

Double-click type layer thumbnail

Alt-click the line dividing two layers

Double-click the layer name

Double-click the filter effect

Double-click the Flter Blending icon

Control-click New Group button

Alt-click New Group button

Alt-click Add Layer Mask button

Control-click Add Layer Mask button

Control + Alt-click Add Layer Mask
button

Right-click layer group and choose
Group Properties, or double-click
group

Shift-click

Shift-click

Control-click

Double-click type layer thumbnail

Option-click the line dividing two layers

Double-click the layer name

Double-click the filter effect

Double-click the Filter Blending icon

Command-dick New Group button

Option-click New Group button

Option-click Add Layer Mask button

Command-dick Add Layer Mask button

Command + Option-click Add Layer

Mask button

Control-click the layer group and choose

Group Properties, or double-click group

Shift-click

Shift-click

Command-click

MNote:

If Kotoer 1s your Japanese language Input method, the "Toggle rubylith mode for layer mask on/off” shortout starts an action In Kotoerl
Please switch to another mode (for example, "U.S") to enable this shortcut.
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Use the Layer Comps panel

Result

Create new layer comp without the New Layer
Comp box

Open Layer Comp Options dialog box
Rename in-line
Select/deselect multiple contiguous layer comps

Select/deselect multiple discontiguous layer
COMmps

Use the Paths panel

Result

Load path as selection
Add path to selection
Subtract path from selection

Retain intersection of path as selection

Hide path

Set options for Fill Path with Foreground Color button, Stroke Path with

Windows

Alt-click Create New Layer Comp
button

Double-dick layer comp

Double-click layer comp name

Shift-click

Control-click

mac0S

Option-click Create Mew Layer Comp
button

Double-click layer comp

Double-click layer comp name

Shift-click

Command-click

Windows macO5
Control-click Command-click
pathname pathname

Control + Shift-click | Command + Shift-click
pathname pathname

Control + Alt-dlick Command + Option-
pathname click pathname

Control + Shift + Command + Shift +
Alt-click pathname | Option-click

pathname

Control + Shift + H Command + Shift + H

Brush button, Load Path as a Selection button, Make Work Path from

Selection button, and Create New Path button
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Alt-click button Option-dlick button



Use Extract and Pattern Maker (optional plug-ins)

Result (Extract and Pattern Maker) Windows macOS

Fit in window Control + 0 Command + 0

Zoom in Control + + (plus) Command + + (plus)
Zoom out Control + - (hyphen) Command + - (hyphen)
Cycle through controls on right from top Tab Tab

Cycle through controls on right from bottom | Shift + Tab Shift + Tab

Temporarily activate Hand tool Spacebar Spacebar

Change Cancel to Reset Alt Option

Result (Extract only) Windows mac05

Edge Highlighter tool B B

Fill tool G G

Eyedropper tocl I 1

Cleanup tool C C

Edge Touchup tool T T

Toggle between Edge Highlighter tool and Alt + Edge Highlighter/Eraser tool Option + Edge Highlighter/Eraser tool
Eraser tool
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Use the Swatches panel

Result

Create new swatch from foreground color

Set swatch color as background color

Delete swatch

Toggle Smart Highlighting

Remove current highlight

Highlight entire image

Fill foreground area and preview extraction

Mowve mask when Edge Touchup tool is
selected

Add opacity when Cleanup tool is selected

Toggle Show menu opticns in preview
between Original and Extracted

Enable Cleanup and Edge Touchup tools
before preview

Cycle through Display menu in preview
from top to bottom

Cycle through Display menu in preview
from bottom to top

Dereasefincrease brush size by 1

Decrease/increase brush size by 1
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Windows

Click im empty area of panel

Control-click swatch

Alt-click swatch

Control with Edge Highlighter tool
selected

Alt + Delete

Control + Delete

Shift-click with Fill tool selected

Control-drag

Alt-drag

Shift + X

Shift +F

Down Arrow/Up Arrow in Brush Size

text boxt

Left Arrow/Right Arrow with Brush
size Slider showing?

macOs

Click in empty area of panel

Command-dick swatch

Option-click swatch

Command with Edge Highlighter tool

selected

Option + Delete

Command + Delete

Shift-click with Fill tool selected

Command-drag

Option-drag

Shift + X

Shift + F

Down Ammow or Up Arrow in Brush
Size text box!

Left Arrow/Right Ammow with Brush
Size Slider showing’



Set strength of Cleanup or Edge Touch-up 0-9 0-9

tool

THold down Shift to decrease/inarease by 10

Result (Pattern Maker only) Windows mac0s

Delete current selection Control + D Command + D
Unde a selection move Control +Z Command + Z
Generate or generate again Control + G Command + G
Intersect with current selection Shift + Alt + select Shift + Option + select
Toggle view: original/generated pattern X X

Go to first tile in Tile History Home Home

Go to last tile in Tile History End End

Go to previous tile in Tile History

Left Arrow, Page Up

Left Arrow, Page Up

Go to next tile in Tile History

Right Arrow, Page Down

Right Arrow, Page Down

Delete current tile from Tile History

Delete

Mudge selection when viewing the original

Right Arrow, Left Arrow, Up Arrow, or
Down Arrow

Right Arrow, Left Arrow, Up Arrow, or
Down Arrow

Increase selection nudging when viewing
the original

Shift + Right Arrow, Left Arrow, Up
Arrow, or Down Armow

Shift + Right Arrow, Left Arrow, Up
Arrow, or Down Arrow

COPY_RIGHT@ADOBE>>

SSSS5>55>555555>>>> THANK YOU  cocccccccc<<<<L<<
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CONNECT WITH ME __

https://www.facebook.com/sahan.kanchana.18
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